
Basic Computer Use - Hints & Tips 
 
 

 
October 2010 



 

General Practice South October 2010           Page 2 

This document is intended as a beginners guide to some of the fundamental concepts and terminology  
encountered when using  a personal computer and navigating the internet. It is by no means 
comprehensive or exhaustive, but is designed to provide some basic assistance to General Practice staff in 
regard to the technology environment they are most likely to be working in, and the terms they may  
encounter. 
 
The most widespread configuration in use in General Practice in Southern Tasmania is an IBM compatible, 
Windows XP workstation, with an internet connection and a Microsoft Outlook based email program, (if any). 
It is this general working environment that this guide is centered around. This guide does not contain 
information on clinical software. 
 
Much of the following information is applicable to other Microsoft Operating Systems. Similarly much of the 
email information can apply to multiple versions of Microsoft’s Outlook program.  
 
Please note that some of the screens or information depicted may differ from your system, as a result of user 
or employer configuration of your practice IT environment.  
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The Screen 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

Quick Tips 

 
 
 
 
 
 
 
 
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Terminal Services In a Terminal Services environment, you log on twice, once to the computer in front of you, 
(the “local” machine) and then to the main computer or “server”. In this setup, it is as if you are sitting in front of 
the server itself. So the Desktop, and any icons, folders, or drives that you see, are actually on the main com-
puter, and not the one you are sitting in front of. You can however, minimise the server screen, and view the 
desktop and drives of your local computer.  
 
 NB. Some key combinations will work differently in a Terminal Server environment.   
 
Save Save Save. If you are working on a large document, save it often. It takes almost no time and saves much 
heartache if your computer “crashes”. 
 
Save As. If you want to create a document from another document. Open the original and under the File menu, 
select Save As, specifying a new file name. This will close the original file untouched, and give you an exact 
copy of the document to work on. 

Basic Computer Usage 

Start Menu: 
You can access all the 
programs, and your computer 
configuration via this button. 
Some programs also install a 
shortcut icon here. 

Quick-Launch toolbar: 
Start these programs with a 
single click. Add to the Quick 
Launch programs by dragging 
an icon from your desktop 
onto the toolbar. 

Desktop: 
This is the big area of the 
screen containing your program 
icons and any background 
graphics that are set up.  

Show Desktop Icon: 
Minimise all open 
programs by clicking on this. 

Taskbar: 
These are the applications 
that are currently running and 
can be accessed by a single 
click. 

Notification Area or System Tray:  
These icons represent small utilities 
and services that are currently running 
on your computer, e.g your anti-virus 
program, email notification, Microsoft 
update agents, utilities for adjusting 
your speaker volume, etc. If needed 
you can access these services with a 
double click. 

Task Manager: 
Right-Click on any free spot 
on the Taskbar and you can 
bring up the Task Manager. 
This shows everything that is 
currently running on your 
COMPUTER. You can use the 
End Task button to close a 
“crashed” program, that you 
are unable to close in the 
usual way. These programs 
will usually show as “Not Re-
sponding” 

NB: The above represents the layout of a typical Microsoft Windows XP workstation. There may be 
slight differences in appearance, depending upon the version of Microsoft Windows installed, or any 
customizations implemented by the user or employer. 
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Folders/Drives 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Desktop is a special folder that contains all the files and icons that you see on your computer desktop. If you 
save a file to this folder, it will appear on your computer desktop along with your icons. If multiple people have 
logins at a computer, they will each have their own Desktop folder. 
 
My Documents is another special folder that is set up as a default location for all your personal documents and 
files. If multiple people have logins at a computer, they will each have their own My Documents folder, and will 
be unable to see other people’s. 
 
(A:) If you have a floppy disk drive on your computer, it will show as (A:) 
 
(C:) This is the hard disk of the computer that sits on your desk. It contains all of the files, folders, icons, and 
shortcuts mentioned above, and all programs installed on your computer. In a home situation you will save all 
your files here, (probably in My Documents). In a work situation you won’t save any important work here, as it 
is not backed up regularly. 
 
(D:) or (E:) This is typically your DVD or CD ROM Drive. If your computer has a second hard drive then it will 
probably be (D:) with your DVD/CD drive being (E:) 
 
Removable Drive(s) These will be any USB drive(s) plugged into your computer. These devices are some-
times called “flash drives” or “thumb drives” and generally occupy the next available letter after your DVD/CD 
drive. 
 
NB Any letters higher than this will usually only be in a work environment, and will represent drives on your net-
work file server. This is where important work should be saved, as these drives are backed up regularly.  
 
(H:) If you work in a very large practice, you may have your own private (H) Home directory on the server 
 
(P:)  This is a common example of a shared Network Drive. It is on the server and can be usually accessed by 
everybody. Typically it will contain shared documents and manuals. 
 
Control Panel  From here you can access a lot of your computer’s configuration information, including 
connected printers 
 
My Network Places This is where you can browse and see what other computers are on the network. (You  
generally do not need to go here.) 
 
Recycle Bin This is where your deleted files go. If you have made a mistake you can retrieve files from here. 
There is also an icon for this on your desktop. 

Basic Computer Usage 
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Mouse 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

Keystrokes 
 
 
 
 
 
 
 

Basic Computer Usage 

Right Click, a wealth of functionality at your 
fingertips, consider the following examples: 
 
NB: Always try Right-Clicking if you can’t find 
how to do something. 

 
Single Left Click  on a web hyperlink, a menu option, a program icon or an icon on your taskbar, (usually right 
at the bottom of your screen) 
 
Double Left Click  on a desktop icon, or a file that you want to open.  
 
Left Click—Drag  (clicking and holding the mouse button down, and then moving the mouse.) Do this on the 
scroll bars showing at the right and/or bottom of the screen and you can quickly move through a large document 
or web page. Use this technique on a file or icon and you can move it to a new location. Do this on the Blue Bar 
at the top of a window and you can move it around the screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Right Click…Send To...Desktop.  on any file or folder anywhere on your system and you can create a shortcut 
to it on your desktop. 
 
Right Click…Send To...Mail Recipient.  on a file and a new email window will be generated with the file in-
cluded as an attachment 
 
Right Click…Copy, on selected text or file(s) and your selection will be copied to temporary memory, ready to 
be pasted into another location(s). 
 
Right Click…Cut, on selected text or file(s) and your selection will be deleted and copied to temporary mem-
ory, ready to be pasted into another location(s). 
 
Right Click…Paste, once you have copied or cut something, you can use this to paste into the new location. 
Once you have copied something you can paste it multiple times. 
  
Right Click…Properties, on a file to find out how big it is, when it was created and when it was last modified. 
  
Right Click…Properties, on your computer desktop to change the screen resolution or your background  
picture. 
 
NB: The following key combinations  are very handy 
 
Ctrl -A    Selects all the text in a document  
Ctrl -C    Copies all selected text or selected file(s) 
Ctrl -X    Deletes all selected text or selected file(s) 
Ctrl -V    Pastes all copied or deleted  text or selected file(s) to a new location 
Ctrl -B    Makes any selected text Bold. 
Ctrl -I     Makes any selected text Italic. 
Ctrl -U    Makes any selected text Underlined. 
Ctrl -F    Brings up a “Find” search box in many applications 
Ctrl -S    Saves the document you are working on in most applications. 
Ctrl-Z     Undoes your last action in many applications.. 
Ctrl -Esc   Brings up the Windows start Menu 
Ctrl-Alt-Del   Brings up a window that lets you log off, shut down or securely look your computer 
Alt -F –   Accesses the “File” menu in most applications. 
Alt-Tab   Brings up a list of currently running programs. Hold the Alt Key down and tap the Tab key, and 
 you can cycle through the programs you are running. 
Windows –D Minimises all your open windows and shows your Desktop. 
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Assorted Tips 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 

 
Use Favourites. Organise your favourite web sites by creating sub-folders in your Favourites. 
From the Favourites menu or icon, select Organise Favourites. New Folder. Here you can create named folders 
and drag your existing favourites into them. You can add the web page you are viewing as a favourite by  
pressing Ctrl-D, or by going to the Favourites menu/Icon and selecting Add Favourite.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Take your Favourites with you. You can save your favourites to a small file and take it with you to install on 
another computer. Go to the File Menu and select Import Export…Export Favourites. You will be prompted for a 
location to save your favourites file. This file can then be taken to another computer, and loaded by going to the 
File Menu and selecting Import Export…Import Favourites. 
 
Set your Home Page.  Load the page you want to keep as your home page, (www.gpsouth.com.au would be a 
good choice!). Go to the Tools menu, and select Internet Options…General.. and click on Use Current. Now this 
page will always be opened when you start Internet Explorer. 
 
Go Back  If you have recently been on a web page, and are having trouble finding it again, press  Ctrl-H. This 
will bring up your recent browsing history, find the page and click on it to go there. Press Ctrl-H again to hide the 
History screen. 

 
Go Back  and Forwards. Use the two arrows at the top left of your screen to scroll between the pages you have 
been viewing during the current browsing session. 
 
Go Forward but keep your Spot. If you want to stay on the current page, but also follow a link from it, just 
Right-Click on the hyperlink and select Open in New Tab or Open in New Window. 
 
Place the web page on your desktop. If you want a shortcut on your Desktop to a place on the internet you 
can Right-Click on a link and select Copy Shortcut, and then Right-Click on your desktop and choose Paste  
shortcut. Alternately you can have the web page open, reduce the size of the window, and click and drag the 
web address from the location bar to your desktop. 
 
Refresh the Page. Depending on your browser settings, you may be looking at a previously downloaded web 
page, and not the most recent version. To force your web browser to get the most up to date version of the 
page, hit the F5 key. Note, even this may not work optimally in DHHS sites. 
 
Enlarge the text. If you are struggling to read a web page, go to the View menu and select Text Size. From 
here you can increase or decrease the size of text on the page. You can also generate a page refresh from the 
View menu.  
 
Search the Page. You probably have a Search box in the top right hand corner of your web browser. If you click 
the downward facing arrow next to the box, you can choose Search in Page. Just type in the word you are  
looking for, click on the magnifying glass, and the current page will be searched.  
 
Read your Screen. Sometimes a page will not load or only partially load. This may be due to one of Microsoft’s 
security tools, blocking something on the page. This information is often highlighted in an extra menu bar at the 
top of the page. If you click the bar you are usually given an option to ignore the warning and fully load the page. 

 
Lose the http://. If you have to manually type an address into the Address Bar, don’t worry about the first part of 
the link, i.e. http://. Modern browsers can ascertain the relevant site, without this. 
 
 

            Browsing the World Wide Web using Internet Explorer © 
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Google Tips 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Internet Lingo 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

 

 
Google is a calculator. Type in your sum and hit the search button.  E.g. 16/8=2  16*8=128. Google can also 
perform currency calculations and other conversions. 
 
Use Quotes.  Search more effectively by putting quotes around a search phrase, e.g. “Tower of London” 
  
Exclude things.  Use a minus sign to exclude certain pages from a search, e.g. Bass –fish would find pages 
containing the word Bass, excluding ones that mentioned fish. 
 
Specify a site.  Use the site parameter to search on a specific site. e.g. The following search string “template 
site:gpsouth.com.au” would search www.gpsouth.com.au for the word “template”. 
 
Specify a Time. Under Google’s More Search Tools option, you can specify what timeframes you want for your 
information search. e.g. Only pages updated in the last month.  

 
Use Google Maps. Brilliant free technology for finding how to get to anywhere. You can specify starting and 
finishing locations, and Google will give you full directions and even calculate how long it will take you to get 
there, driving or walking. You will find a good example of this functionality at the GPSouth website.  
 
 
Some common words you may hear. 
 
Broadband: An internet connection that is always “on”. In the early life of the internet, connectivity was 
established through “Dial Up” modems, whereby you would connect and disconnect between internet sessions.  
 
Browser: Any program used to access the World Wide Web (WWW). Usually Internet Explorer or Firefox, but 
there are others. 
 
Cookie:  A cookie is information that a Web site puts on your hard disk, in the shape of a very small file so that it 
can remember something about you at a later time. Commonly they are used to track your activity at a given 
website, so that site advertising can be tailored to your interests. 
 
Download: The act of transferring a file from another location, to your computer, generally via the internet. 
 
FAQ: (Frequently Asked Questions). Information presented in a Question and answer format, answering the 
most common questions on a given subject. 
 
Fire Wall: A protection device or program that shields your computer from unauthorised or malicious internet 
users. Most Modems contain an inbuilt firewall, and Microsoft provides an inbuilt firewall program with Windows. 
 
Hotmail: An email account that you can access and use through a web browser from any internet connected 
computer in the world. Bigpond, Yahoo, Google and others provide similar email services. 
 
Intranet: Is a private in-house internet system, for the access of internal users only. Large employers often have 
these as a means of sharing documents, policies etc. 
 
ISP (Internet Service Provider): This is the organisation that provides your access to the Internet. Local  
examples are Telstra Bigpond, Eftel, Netspace, but there are many others. 
 
Modem: Is the name of the device that connects to the internet. A modem can be attached to just one computer 
or many computers. 
 
Network: Any group of computers that are connected in some way. Almost all  practices have a network. 
 
PDF: (Portable Document Format) The most common document format on the internet. To read PDF files you 
need to have the free Adobe Reader © program installed on your computer. It is available via the internet. 
 
Phishing: The practice of fraudulently luring users to a bogus website, with the aim of extracting personal  
account and password information. 
 
Search Engine: is an internet site designed to help you find things on the WWW. e.g. www.google.com 
 
Spam: Unsolicited email containing advertising, or as part of a scam. Spam is the scourge of the internet, with 
almost 90% of all emails being spam. Also gave rise to SPIT (Spam over Internet Telephony) 
 
Spyware: A program secretly installed on your computer, via a website or an email. Used to monitor your inter-
net habits, or to collect and transmit your personal details. 
 
WWW (World Wide Web) This is the visible face of the internet, and is interchangeable with the word Internet. 

            Browsing the World Wide Web using Internet Explorer © 
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Distribution 

Lists 
 

 
 

 
 
 
 
 

Attachments 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Attachment 
Tips 

 
 
 
 
 
 
 
 
 

Other Email 
Tips 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Etiquette and 
More 

 
 

 

 
Create when you regularly email a consistent group of people 
From the File Menu, Select New…Distribution List 
Select Members from your Contact Lists or add them manually. 
Name the list accordingly 
When you want to email the group, select the group rather than an individual. 
 
NB: If you are using Outlook Express, the steps are: 

Click on the Addresses button 
Click on the New Button 
Select New Group 

 
        
A useful way of sending documents, or photo’s to somebody. 
To attach a file, compose a new email and then either click on the paperclip icon or chose Insert..File from the 
menu. Then browse to where you have the file saved, choose the file and click on Insert. If you want to select 
multiple files to attach, hold down the Ctrl key. 
 
NB: Holding down the Ctrl key so you can select multiple items with your mouse is a common technique that can 
be used in many computer programs. Similarly holding down the Shift Key and clicking the first and last item in a 
group is an easy way to select the whole group. 
 
You can also attach a file to an email by simply Right-Clicking on the file and choosing Send To….Mail Recipi-
ent . This will result in a new email window being opened up with the file already attached. From here simply 
select the recipient and type in your message. 
 
NB: Right-Clicking is also a common technique that is used in many computer programs. It will usually bring up a 
shortcut menu of the things you most commonly want to do in that situation. So if you are stuck, try Right-
Clicking on an item, or on the area you are working in. 
 
Be aware of file sizes. Really big files (movies etc), may cause a problem at the receiving end. Some Email  
users have a maximum file size that they are able to accept. 
 
Be aware of what programs the email recipient has. For example, If you send an Access database file to some-
body without Access, they won’t be able to open it. 
 
Don’t open attachments from unknown or suspicious sources. If you don’t recognise the person who sent you 
the email don’t take the risk of opening the attachment. It could be a virus, or a utility that sends away your per-
sonal details. Banks never send you web-links with instructions to input your password. 
 
NB: 90% of emails are either unsolicited advertising, malicious programs or links.  
 
Create sub folders under your inbox for emails you want to keep. We all work differently, but a minimal amount 
of email in the inbox helps ensure nothing gets missed. To do this Right-Click on your inbox and select New 
Folder. Name the folder and then drag the appropriate emails into it. 
  
Create an email Signature. Go to Tools..Options…Mail Format..Signature, and create an email footer that will 
automatically be included on every email. Show your name, title, phone number and email, for example. 
NB: In Outlook Express use Tools..Options…Signature 
  
Use Calendar and Tasks to organise things and set yourself reminders. 
  
Use Email Forwarding to send an email you have previously sent to another person. e.g you send a long email 
to person A, and then realise you want to also send to Person B. Just open the original email and from the  
toolbar select Forward, then specify Person B’s email address.  
 
You can also access Forward  from the Actions menu, as well as Resend, which as the name implies resends 
the email to the original recipient. 
  
Mail Boxes have Column Headings for Sender, Date, Subject etc. Click on any of these column headings to sort 
the messages accordingly. 
 
   
DON’T SHOUT. Typing in all uppercase in email is generally considered aggressive, so use lower case. Case 
in email addresses isn’t a factor, use lower case and you will be fine. 
  
USE Bcc. If you are sending to a large list of people, it is polite not to send everybody’s email address to  
those that you are sending to. Put the addresses into the Bcc field rather than the To: field. You may have to 
make this field visible by going to the View menu, and clicking the Bcc field, or the All Headers option if you are 
using Outlook Express. 

            Email using Microsoft Outlook © 
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            Appendix 1 - Windows XP © Keyboard Shortcuts 

 
CTRL+C   (Copy) 

CTRL+X   (Cut) 

CTRL+V   (Paste) 

CTRL+Z   (Undo) 

DELETE   (Delete) 

 

SHIFT+DELETE    (Delete the selected item permanently without placing the item in the Recycle Bin) 

CTRL while dragging an item  (Copy the selected item) 

CTRL+SHIFT while dragging file (Create a shortcut to the selected item) 

F2 key     (Rename the selected item) 

CTRL+RIGHT ARROW   (Move the insertion point to the beginning of the next word) 

CTRL+LEFT ARROW   (Move the insertion point to the beginning of the previous word) 

CTRL+DOWN ARROW   (Move the insertion point to the beginning of the next paragraph) 

CTRL+UP ARROW    (Move the insertion point to the beginning of the previous paragraph) 

CTRL+SHIFT with any arrow key (Highlight a block of text) 

SHIFT with any arrow key   (Select more than one item in a window or on the desktop, or select text in a document) 

CTRL+A     (Select all) 

F3 key     (Search for a file or a folder) 

ALT+ENTER     (View the properties for the selected item) 

ALT+F4     (Close the active item, or quit the active program) 

ALT+ENTER     (Display the properties of the selected object) 

ALT+SPACEBAR    (Open the shortcut menu for the active window) 

CTRL+F4     (Close the active document in programs that enable you to have multiple documents open) 

ALT+TAB     (Switch between the open items) 

ALT+ESC     (Cycle through items in the order that they had been opened) 

F6 key     (Cycle through the screen elements in a window or on the desktop) 

F4 key     (Display the Address bar list in My Computer or Windows Explorer) 

SHIFT+F10     (Display the shortcut menu for the selected item) 

ALT+SPACEBAR    (Display the System menu for the active window) 

CTRL+ESC     (Display the Start menu) 

ALT+Underlined letter in a menu  (Display the corresponding menu) 

F10 key     (Activate the menu bar in the active program) 

RIGHT ARROW    (Open the next menu to the right, or open a submenu) 

LEFT ARROW    (Open the next menu to the left, or close a submenu) 

F5 key     (Update the active window) 

BACKSPACE    (View the folder one level up in My Computer or Windows Explorer) 

ESC      (Cancel the current task) 

CTRL+SHIFT+ESC    (Open Task Manager) 

SHIFT when you insert a CD (Prevent the CD-ROM from automatically playing) 

 
 
 

** Keystrokes sourced from Microsoft Support website 
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            Appendix 2 - Medical Director Keyboard Shortcuts 
Main Window 
 
F1   Help 

F2   Open Patients 

F4   Import Investigation Results 

F5   Check Investigation Results 

F6   MDref 

F7   Log off 

F8   Letter Writer 

F9   Batch Print 

F12   Product Information 

CTRL + K  Address Book 

CTRL + T  Patient Education  

 
 
Progress Notes 
 
CTRL + SHIFT + A  Append 

CTRL + SHIFT + C  Clear Search 

CTRL + SHIFT + N Comment 

CTRL + SHIFT + D  Diagram 

CTRL + SHIFT + E  Examination 

CTRL + SHIFT + H  History 

CTRL + SHIFT + G  Management 

CTRL + SHIFT + M  Medicare 

CTRL + SHIFT + O  Procedure 

CTRL + SHIFT + R  Reason 

CTRL + SHIFT + W  Review 

CTRL + SHIFT + S    Search 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

** Keystrokes sourced from HCN Support documentation. 

Clinical Window 
 
F1   Help 
F2   Open Patients 
F3   Add New Item 
F4   Recall 
F5   Check Investigation Results 
F6   MDref 
F7   Allergies and Warnings 
F8   Letter Writer 
F9   Print Progress Note 
F10   Edit Patient Details 
F12   Product Information 
ALT + A  Assessment Menu 
ALT + B  Obstetrics 
ALT + C  Clinical Menu 
ALT + D  Documents 
ALT + E  Edit Menu 
ALT + F  File Menu 
ALT + G  Progress Notes 
ALT + H  Past History 
ALT + I  Immunisations 
ALT + M  MDPlus menu (if installed) 
ALT + L  Letters tab 
ALT + M  Pap Smears 
ALT + O  Old Scripts 
ALT + P  Patient Menu 
ALT + R  Resources Menu 
ALT + S  Summaries Menu 
ALT + T  Tools Menu 
ALT + U  Results tab 
ALT + W  Window Menu 
ALT + X  Current Medications 
ALT + Y  Summary 
ALT + F2  Opens a second patient. 
ALT + F4  Close Program 
CTRL + T  Patient Education Browser 
CTRL + K  Address Book 
CTRL + D  Edit Patient Details 
CTRL + P  Print 
CTRL + F1  Prescribe Flu Vaccine 
CTRL + F2  Adds patient if not linked to a billing package 
CTRL + F3  Prescribe Favourites 
CTRL + F4  Close Patient 
 
CTRL + ALT + B  Opens the BP Monitor 
CTRL + ALT + C  Cardiovascular Risk 
CTRL + ALT + E  Echo Cardiograph 
CTRL + ALT + G  Opens the Blood Glucose Monitor 
CTRL + ALT + I  INR Record 
CTRL + ALT + L  Lock MD 
CTRL + ALT + R  Respiratory Function 
CTRL + ALT + T  Tool Box 
CTRL + ALT + W  Weight 
CTRL + Z   Undo last action 
SHIFT + F1   'What is This?' Tool‐tip Help Menu 
SHIFT + F2   Add Patient to Existing Family 
SHIFT + F3   Prescribe Drug Protocol 
SHIFT + F4   Pathology Request 
SHIFT + F5   Print Patient Health Summary 
SHIFT + F12   Consumer Medications Information 
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            Appendix 3 - Pracsoft Keyboard Shortcuts 
 
Types of Appointment 
 

Ctrl + P  Procedures 

Ctrl + V  Vaccination 

Ctrl + B  Obstetrics 

Ctrl + T  Blood Test 

Ctrl + U  Acupuncture 

Ctrl + E  Emergency 

Ctrl + D  Dressing 

Ctrl + S  Script 

Ctrl + F  Blood Test Fasting 

Ctrl + O  Ordinary Appointment 

Ctrl + L  Blood Pressure 

Ctrl + H  Home Visit 

Ctrl + M  Pap Smear 

Ctrl + X  Custom Type "X" 

Ctrl + Y  Custom Type "Y" 

Ctrl + Z  Custom Type "Z" 

 

Appointment Book 
 

F11   Next Day 

F12   Next Week 

F8   Next 4 Weeks 

F9   Today's Date 

F2   Find a Patient's Appointment 

Ctrl + W  Add Patient to Waiting Room 

Ctrl + I  Open Patient in Medical Director 

Ctrl + Ins Cut 

Shift + Del  Delete range of appointments (in one column) 

Shift + Ins Paste 

CTRL + G  Gone 

Ctrl + A  Add a "Fit In" Appointment 

 
 
 
 
 
 
 

** Keystrokes sourced from HCN Support documentation. 
 
 
 
 
 
 
 
 
 

 
Record a Visit 
 

F12   Display Receipt Information 

Ctrl + S  Search For Item Number 

Ctrl + N  Add Visit For Same Patient 

Alt + S  Save, No Print 

Alt + P  Print Receipt 

 

General 
 
F1   Help 

F6   Add New Patient 

Ctrl + L  Log Off 

Ctrl + R  Refresh 

 

Waiting Room 
 
F2   Find a Patient 

F3   Add Patient to Waiting Room 

F5   Record a Visit 

F7   View Patient Details 



 

General Practice South October 2010           Page 12 

            Appendix 4 - Best Practice Keyboard Shortcuts 
 
Main Menu 
 
F1  Help Library 
F2  Open Patient 
F3  Inbox 
F4  Word Processor 
F5  Refresh 
F6  To Do List 
F7  Log off/Cancel Access 
F8  Internal Messenger 
F9  Batch Print 
F10  View Patients 
F11  Contacts 
F12  Product Information 
 
Patient Menu 
 
F1  Help Library 
F2  Open Patient 
F3  Add New 
F4  Word Processor 
F5  Refresh 
F6  To Do List 
F7  Edit Patient Allergies 
F8  Internal Messenger 
F9  Print 
F10  Edit Patient Details 
F11  Contacts 
F12  Product Information 
 
Patient Tree View 
 
Ctrl-Alt-T  Today's notes 
Ctrl-Alt-V  Past visits 
Ctrl-Alt-X  Current Rx 
Ctrl-Alt-H  History 
Ctrl-Alt-I  Immunisations 
Ctrl-Alt-R  Investigation Reports 
Ctrl-Alt-C  Correspondence Out 
Ctrl-Alt-N  Correspondence In 
Ctrl-Alt-P  Past prescriptions 
Ctrl-Alt-O  Observations 
Ctrl-Alt-F  Family/Social 
Ctrl-Alt-Y  Obstetric 
Ctrl-Alt-S  Pap smears 
Ctrl-Alt-E  EPC 
Ctrl-Alt-A  Health assessments 

Ctrl-Alt-L  Care plans 

Ctrl-Alt-M  Medication reviews 

Ctrl-Alt-D  Diabetes cycle of care 

 
 
 
 
 

 
Appointments 
 
F1  Help Library 
F2  Find Appointment 
F3  New Appointment 
F4  Arrive Patient 
F5  Refresh 
F6  Create Account 
F7  Process Payment 
F8  Internal Messenger 
F9  Print Day Sheet 
F10  Account History 
F11  Contacts 
F12  Waiting Room 
 
CTRL+O  New Appointment 
CTRL+W  Arrive Patient 
CTRL+F4  Close 
 
Waiting Room 
 
F1  Help Library 
F2  Start Visit 
F3  Add to Waiting Room 
F4  View notes 
F5  Refresh 
F6  Create Account 
F7  Process Payment 
F8  Internal Messenger 
F9 
F10  Account History 
F11  Contacts 
F12  Appointment Book 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

** Keystrokes sourced from Best Practice Support documentation. 
 
 
 
 
 
 
 
 
 
 


